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VsamExplorer Users Guide 
 

VsamExplorer may be used for creating and maintaining VsamEx databases. It will perform simple selection 

and reporting using any VsamEx[treme] database. 

 

 
VsamExplorer main window 

 

The main window has a menu, some text boxes, list boxes, check boxes and buttons that can be used to 

control its activities. The Main Window is sizable and can be changed to create a better view of large 

datasets. 
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MENUS: 

 

 

 
 

 

File 

  
Create  Create a new database 

 

Open  Open an existing database 

 

Close  Close an open database 

 

Kill   Kill (delete) a database 

 

Exit   Exit the VsamExplorer 

 

 

 

 
 

 

Edit 

  
Edit Field Definitions… To add, modify or delete field 

    definitions 

View File Control Block Details file stats and field definitions 

 

View Info…  View a shorter Info screen 

 

Register .vol file type So when you click on a .vol file it 

    will launch The VsamExplorer 

 

Unregister .vol file type Reverse of Register 

 

Edit ini File   Edit VsamExplorer parameter file 
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Tools 

 

Report Generator  Launch the VsamEx Report 

    Generator 

 

Validate   Verify integrity of a database 

 

Rebuild   Rebuild a database including 

    the dataset map 

 

Rewrite All   Read ad write all records 

 

Count Records  Count records in database 

 

Delete All Records  Delete all records in database 

 

Export Data and Defs Export records from database  

    and field definitions 

Create Dataset from Defs Create a Dataset from the  

    Data Definitions 

Import a CSV File  Import a Comma Separated  

    Value type file 

 

Export Dict   Export Data Definitions 

 

Import Dict   Import Data Definitions 

 

Export DDF  Export a DDF File 

 

Import DDF  Import DDF File 

 

  

  

 

Help 

 

VsamExplorer Help  Help on using the VsamExplorer 

 

Test Mode   Allows creation, loading and testing 

    a test dataset 

Set License Key  I set a valid License Key into the 

    VsamExplorer 

About VsamExplorer Normal application About box 
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MAIN WINDOW: 

 

                          
 

 

The File button will open a file selection dialog box to browse for and select a VsamEx dataset to open. The 

Open button will toggle between “Open” and “Close” to alternatively open and close the selected dataset. 

 

Below the file name there are check boxes for Write and Shared.  These set the operational mode for the 

open dataset. If the Shared checkbox is not checked, the Report List/ Select will not display any data. 

The check box “No Server” should be checked unless you are using Vservice for accessing a dataset. 

  

On the same line there is a text box for Gsiz and a check box for Encrypt.  The Gsiz box is to set the internal 

group size of a new database. This value should be a multiple of 1024 and the maximum size is 32768.  The 

maximum sized group allows VsamEx to achieve the largest possible dataset (2.1 GB). The Encrypt 

checkbox will make a text box visible to enter an encryption Key.  This Key will be used when creating or 

opening an encrypted database. Data entered into the encryption box will be masked with the “*” character. 

The Key will be used to enable SHA encryption of all data in the dataset. The only way to view or open the 

dataset with encryption is to use the identical Key that was used to encrypt the dataset. The maximum length 

key is 250 characters. 

 

There are three text boxes labeled Secondary, Key, and Field. These track the Secondary Key of an indexed 

field and the records Primary record Key of the current record being displayed. The labels next to the text 

boxes will change to reflect the name of the field the text boxes are currently holding. 

 

Next, below the Field text box, is the record list box that will contain all of the fields of the open database, 

with the Field Name on the left, a “|” character, and the field contents on the right. Notice that the 

Highlighted field also shows above the record list box, with the field name displayed instead of “Field”. 



 5 

 
Below the record list box is a row of buttons used to manipulate the data set one record at a time. 

 New  prompt for data for a new record 

 Edit  Press it to prompt for data for each fields in the current record 

 Write  write record that is in record listbox 

 |<  read first record 

 <-  read previous record 

 Read  read record whose key is in the key text box 

 ->  read the next record 

 >|  read the last record 

 Delete  delete the record whose key is in the key text box 
 

Below the manipulation buttons are three check boxes; Add Only prevents the system from overwriting an 

existing record. No Edit will not allow the contents record to be over-written. Auto Write automatically 

updates records when they change for any reason. 

 

On the next line is the Index combo box.  It is used to select the indexed field to be used by the navigation 

buttons on the line above. This is one of the fields specified as a secondary index. 

 

On the right is the Stop button.  It is used to stop a long operation like Search, Add, Read or Load below. 

 

The next line starts with the Clear button on the left.  It is used to clear the selection list box that is below it. 

 

Next to the Clear button is the Fields button.  It is used to change which fields are in the display. 

 

To the right of the Field button is the Reload button used to reload the selection list box below.. 

 

Save the latest Search Results as a Dynaset (a separate VsamEx dataset). 

 

Expert shows an expert helper dialog box for entering complex search criteria. 

 

Search button.  Press it to perform the search requested in the search text box to the right. 

 

The next section down is the selection list box followed by a Status window that displays the results of most 

operations, success, failure, etc. 
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When the Test Mode under the Help menu item is selected, an additional dialog box is opened that provides 

useful tools for testing VsamEx. 

 

 
 

 

 

 

 Testing relies on the structure of the database to be built with the Create button on this dialog box. You can 

select Name, Address Phone and Email fields to be created and populated with data, either sequential or 

random using the Rnd Data & Rnd Key check boxes.  

 

The Add and Read buttons will add or read records in the test database.  The text box between the Add and 

Read buttons can hold a count to tell Add or Read how many records to operate on.  If no number is given 

they will run until the dataset is full or the “Stop” button on the main menu is selected. 
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The following is a guide to using some of the above features: 

 

Create VsamEx database: 

 

To create a new VsamEx database, enter the path and base name of the new database in the text box to the 

right of File on the main window.  Another setting you can alter is Gsiz, which you might want to increase 

if you anticipate having more than 100 MB of data in the database.  Another is Encrypt if you feel that the 

data in the database is sensitive enough that it would benefit by encrypting it.  If you check the Encrypt 
checkbox a field to enter the database password will appear. 

 

Then go to the File menu and select Create.  This will create an empty VsamEx database.  There will be 
only one field defined, the Primary key with the name Primary. 

 

Records in a database consist of the Primary key and other fields you add to the Database Definition   Fields 

must be given unique names.  The Primary key, which you may rename, is always string data.  Other fields 

can be any of String, Integer (16 bit), Long (32 bit), Single (32 bit floating point), Double (64 bit floating 

point), and Currency (64 bit scaled integer).  String fields may be defined as Indexes to allow faster access to 

data.  You should refer to the VsamEx[treme] Reference Manual for details. 

 

To add fields to the database you must first open it.  Go to the File menu and select Open.  Then go to the 

Edit menu and select Edit Field Definitions… This will bring up the Edit Fields Definitions dialog. 
 

 

 
Edit Field Definitions Dialog 

 

With the Edit Field Definitions dialog you can: 

 Add Fields 

 Edit Field Definitions 

 Delete Fields 

 View Database Definition Control Block 
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ADD A FIELD: 

 

To Add a field press the Add Field button.  You then enter a unique Field Name for the new field.  You can 

set the Field Type to one of the supported data types.  If the field is to be a String you may specify that it is 

to be used as an Index.  Two other attributes are useful for display purposes, the Field Width and Field 

Justification. 

 

Once the selections have been make press the Save button to add the field.  If there are no errors the field 

will be added to the database and the field name will be added to the field list on the left of the dialog box. 

 

EDIT A FIELD DEFINITION: 

 

To Edit a field definition select the name of the field to be edited from the list on the left and press the Edit 

Field button.  You can then make changes to the field attributes that are enabled.  You cannot change the 

Field Type but you can change the Field Name, Field Width, and Field Justification.  If the Field Type is 

String you can change the Field Is Index attribute. 

 

DELETE A FIELD: 

 

To Delete a field definition select the name of the field to be deleted from the list on the left and press Delete 

Field.  You will be prompted to confirm that you want to delete the field.  Press Yes to delete it or No to not 

delete it.  If you replay Yes the field name in the list on the left will have „(del)‟ appended to it to show that 

the field has been deleted.  You can Un-Delete any field that has been deleted.  When a records written to the 

database it will not have data for any deleted fields.  The deleted fields will continue to appear in the field 

list, with the „(del)‟, until the database is rebuilt. 

 

VIEW DATA DEFINITIONS CONTROL BLOCK: 

 

Press the View Cb button to view the Data Definitions Control Block. 

 

 
Data Definitions Control Block 
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ADD RECORDS TO DATABASE: 

 

Records can be added to an open database easily. 

 

If the primary keys of the database are numeric, just press the New button and the next higher key will be 

generated and put in the Primary Key text box. 

 

If the primary keys are not to be numeric you can type the key into the Primary Key text box.  To make sure 

you don‟t inadvertently overwrite an existing record you can check the Add Only check box.  With this 

checked the Write button will not replace an existing record. 

 

After the key is in place, the name of the first field will be in the Field Name label to the left of the Field 

Data text box.  Type the contents of the named field into the text box and press Enter.  The text you entered 

will be stored in the Record list box and the name of the next field will be put in the Field Name label and 

the focus will be put in the Field Data text box.  Continue until all data for the record has been entered. 

 

To write the record into the database, press the Write button. 

 

EDIT EXISTING RECORDS: 

 

To edit an existing record that is displayed in the Record list box press the Edit button.  The first field in the 

record will be put in the Field Name and Field Data controls.  You can just press enter to leave the data in 

each field unchanged.  You can type changed data into fields as they appear in the Field controls.  To get to a 

particular field more quickly you can click on it in the Record list box. 

 

To write the changed record to the database, press the Write button. 

 

DELETE A RECORD: 

 

The Delete button will delete the record who‟s key appears in the Primary Key text box.  You will be 

prompted to as if you really want to delete the record. 

 

 
Delete Record Dialog Box 

 

NAVIGATING THROUGH THE DATABASE: 

 

There are several ways to navigate through the records in a database. 

 

You can use the VCR like controls to move through the database. 
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You can enter the key of the record you want to view into the Primary Key text box and press the Read 
button. If the key is not found, the Dataset pointer is positioned such that if you press the Next button ( ->), 

The next record will be read as if there were a record starting with the Key you entered. 

 

You can also enter a Search command in the Search text box and press the Search button.  The list of 

selected primary keys will be loaded into the Select list box.  If you double click on a key in the Select list 

box the record will be loaded in the Record list box. 

 

 
Search Help Screen 

 

 

 

 

 

 

 

CREATE A SIMPLE REPORT: 

 

You can create simple reports by going to the Report Generator menu selection under the Tools top level 

menu. 
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Report Generator Screen 

 

In the above example all fields have been selected and a heading has been specified.  The resulting report is 

shown below: 

 

 
Text Report 

 

 

 

 

 

 

 

You can also create a report as a web page: 
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HTML Report 

 

 

 


